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1. Introduction

Microsoft Excel is an electronic spreadsheet program that can be used to enter data in tabular
form and to perform a large variety of computations on that data. It is the most widely used tool
for performing basic mathematical operations such as summing columns and rows of figures,
finding the average, maximum, or minimum values in a specified range of data, graphing or
charting data to assist users in identifying data trends, sorting and filtering data to find specific
information. In addition, it can even act as a simple database program to store, search, and
retrieve data. Users can learn and apply basic features of Microsoft Excel for their task on their
own, however, when it comes to the use of the more advanced features of Microsoft Excel, a
reference material or manual is a must to have; this is where the importance of consulting this
training material is strongly emphasized- it is prepared in a bid to make learners familiar with the
various facets of Microsoft Excel application software.

The manual is organized into five sections covering topics from basic to advanced features of
the application software. An attempt has been made to make the manual as comprehensive as
possible by incorporating the wealth of features MS-Excel offers. As to the organization of the
manual, the first section is about getting started with Microsoft Excel 2003, section two
discusses with the basic features of Microsoft Excel 2003, section three on worksheet layout
management, section four on drawing or generating various types of charts based on existing
data and setting up pages and section five on advanced topics that targets data management
using features such as sorting and using predefined or existing templates for crating new
workbooks.

Microsoft Excel - Bookl |EEA|
@ File Edit View Inset Format Tools Data Window Help Type a question for help - - 0 X
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2. Starting Microsoft Excel

2.1 Steps for starting word

v" To run Word on your computer
» “Start” >> “Programs” >> “Microsoft Office” >> “Microsoft Office Excel 2003.”
The following is the screen that will be displayed after selecting the previous
sequence of menu commands.

Programs y | Accessories 4
i) Adobe »

L::'! Documents ¥ @ Macromedia b

- ettings , |2 Mirosoft Ofice ¥ i) Microsoft Office Tools ’
™) Nebwork Associates ¥ IEI Microsoft Office Access 2003

/"’; Search » | Startup » E Micrasoft Office Excel 2003
I Utilities ¥ |2 Microsoft Office InfoPsth 2003

@) HebandSupport i o dperfect Office 2000 # @] Microsoft Office PowerPoint 2003

7 Run... Acrobat Distiller 5.0 [B] Microsoft Office Publisher 2003

» Alternatively, if there is an icon of Microsoft Excel available on your desktop (shaped
like a square with a "W" in the middle), you can open up the program by double-
clicking it.

2.2 The Excel Window

Many items you see on the Excel 2003 screen are standard in most other Microsoft software
programs like Word, PowerPoint and previous versions of Excel. Some elements are specific to
this version of Excel.

MName Box Formula Bar Worksheet Window

E3 Microsoft Excel - Book1 |">__<
=

Toolbar5< ] Eile  Edfe  Miew Insert  Formlak  Tools  Data Window  Help _ =
g QP Gal - @ x -sl e Bis e e mi- A
A1 T - =~ I
A e [ ¢ [ o [ E [ F [ & [ H =
1 =
2 Cell Column
3 Headings
4
5
B
7 > Office Assistant |
8 Row Headings
g
1a
11
12
42 o
4 4+ d[\Sheetl  Sheet? £ Sheets |< | >
o] \ MLIM
Nla\.rigation Sheet Tabs

Buttons
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Workbook

Also called a spreadsheet, the Workbook is a unique file created by Excel.
Title bar

E3 Microsoft Excel - Book1 El@| E|

The Title bar displays both the name of the application and the name of the spreadsheet.

Menu bar

@_1 File Edit ‘iew Insert  Formak  Tools Dakta  Window  Help - 8 X

The Menu bar displays all the menus available for use in Excel 2003. The contents of any menu
can be displayed by clicking on the menu name with the left mouse button.

Toolbar

Some commands in the menus have pictures or icons associated with them. These pictures
may also appear as shortcuts in the Toolbar.

Eile Edit Wieww Inserk

| Mew... Chrl4M

| open Chrl4C
Close

=] zave Chrl+-5

Column Headings
LA [ 8 [ ¢c [ b | E | F |

Each Excel spreadsheet contains 256 columns. Each column is named by a letter or
combination of letters.

Row Headings

1

2

3

4

5
Each spreadsheet contains 65,536 rows. Each row is named by a number.
Name Box

B4 -

Shows the address of the current selection or active cell.
Formula Bar
A

Displays information entered-or being entered as you type-in the current or active cell. The contents of a
cell can also be edited in the Formula bar.
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Cell

Microsoft Excel - Book1
@_1 File Edit Miew Insert  Formak  Tools D

RN RENE TR NN A NN -5

: Arial - 10 ~| B I O]

M| e L B —
l]

A cell is an intersection of a column and row. Each cell has a unique cell address. In the picture
above, the cell address of the selected cell is B3. The heavy border around the selected cell is
called the cell pointer.

Navigation Buttons and Sheet Tabs
4 4 » wySheetl / Sheet2 f Sheetd /

Navigation buttons allow you to move to another worksheet in an Excel workbook. Used to
display the first, previous, next or last worksheets in the workbook.

Sheet tabs separate a workbook into specific worksheets. A Workbook defaults to three
worksheets. A Workbook must contain at least one worksheet.

Workbooks and Worksheets

A Workbook automatically shows in the workspace when you open Microsoft Excel 2003. Each
workbook contains three worksheets. A worksheet is a grid of cells, consisting of 65,536 rows
by 256 columns. Spreadsheet information--text, numbers or mathematical formulas--is entered
in the different cells.

A | B | ¢ | D | E | F

[ N T S

Column headings are referenced by alphabetic characters in the gray boxes that run across the
Excel screen, beginning with the Column A and ending with Column V.

Rows are referenced by numbers that appear on the left and then run down the Excel screen.
The first row is named Row 1 and the last row is named 65536.

Important Terms
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o A workbook is made up of three worksheets.

o The worksheets are labeled Sheetl, Sheet2, and Sheet3.

o Each Excel worksheet is made up of columns and rows.

o Inorderto access a worksheet, click on the tab that says Sheet#.
The Cell

An Excel worksheet is made up of columns and rows. Where these columns and rows intersect,
they form little boxes called cells. The active cell, or the cell that can be acted upon, reveals a

dark border. All other cells reveal a light gray border. Each cell has a name. Its name is
comprised of two parts: the column letter and the row number.

E Microsoft Excel - Book1

E‘_W File Wiewd Imsert  Formak  Tools  Data  window  Help - 0 X
N EHRA G 6B 8 5-20e H
 Avial -0 - B I U EE=E|EE| A~
3 . - i

Ay | B [ e | b | E | F [ &6 F
1 £
2
3 I;'
Row Cell Fointer Column Heading

Heading Cell Address

In the following picture the cell C3, formed by the intersection of column C and row 3, contains
the dark border. It is the active cell.

A | B [ e ] b | E | F |

00| | = DD B | —

# Important Terms

o Each cell has a unique cell address composed of a cell's column and row.
o The active cell is the cell that receives the data or command you give it.
o A darkened border, called the cell pointer, identifies it.

Moving around the worksheet

You can move around the spreadsheet in several different ways.

To Move the Cell Pointer:

> To activate any cell, point to a cell with the mouse and click.
» To move the pointer one cell to the left, right, up, or down, use the keyboard arrow
keys.
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To Scroll Through the worksheet:
The vertical scroll bar located along the right edge of the screen is used to move up or down
the spreadsheet. The horizontal scroll bar located at the bottom of the screen is used to move

left or right across the spreadsheet.
[ E [ E [ = [ H =]

“wertical
Scroll Ear

Horizontal
Scroll Bar

l< > Iv
The PageUp and PageDown keys on the keyboard are used to move the cursor up or down
one screen at a time. Other keys that move the active cell are Home, which moves to the first
column on the current row, and Ctrl+Home, which moves the cursor to the top left corner of the

spreadsheet or cell Al.

To Move between worksheets

As mentioned, each Workbook defaults to three worksheets. These worksheets are represented
by tabs-named Sheetl, Sheet2 and Sheet3-that appear at the bottom of the Excel window.

To Move from one worksheet to another worksheet:

» Click on the sheet tab (Sheetl, Sheet2 or Sheet 3) that you want to display

16 ot
M 4« » W] Sheetl  Sheetz f Sheets /|« |

Readw IR
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3. Microsoft Excel Basics

3.1 Creating, Opening and Saving Workbooks

3.1.1 Understanding File Terms
The File menu contains all the operations that we will discuss in this section: New, Open,
Close, Save and Save As.

[ File | Edit  wiew Insert Fo

L1 Hew... Chrl+1

L Spen... ChrlHC
Close

=l save Ckrl4-5
Sawve As...

New

Used to create a new Workbook.

Open

Used to open an existing file from a floppy disk or hard drive of your computer.
Close

Used to close a spreadsheet.

Save As

Used when to save a new file for the first time or save an existing file with a different name.
Save

Used to save a file that has had changes made to it. If you close the workbook without saving
then any changes made will be lost.
3.1.1 Creating a workbook

A blank workbook is displayed when Microsoft Excel is first opened. You can type information or
design a layout directly in this blank workbook.

To Create an Excel Workbook:
» Choose File>>New from the menu bar.

File | Edit Wiew Insert Fo

|0 Mew.. . o

= gpen...ht‘ D
Close

= save Ckrl+5
Save As
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» The New Workbook task pane opens on the right side of the screen.

E3 Microsoft Excel - Book1

@ File Edit Miew Insert Format Tools Data Window  Help - B X
P T el (A S % Sa @ B RS ARNTHCY
i Arial -0 - | B 7 U =EE=E =|E S| - A -
A0 - b

] al B | © | D ': ENEW Workbook - X
5 ®|® | A

3 MNews

4 _] Blank workboo

5 @j From existing workboaol, .,

? Templates

Search online For:

[a]

9 Cia

10 2y Templates on OfFfice Cnline

11 E] on my computer. ..

12 ~ [ Ononvy Web sites. ..
M 4 » ]} Sheetl  Shestz|< | -
Ready MM

» Choose Blank Workbook under the New category heading.
» A blank workbook opens in the Excel window. The New Workbook task pane is closed.
3.1.2 Saving a workbook

Every workbook created in Excel must be saved and assigned a name to distinguish it from
other workbooks. The first time you save a workbook, Excel will prompt you to assign a name
through the Save As operation. Once assigned a name, any additional changes made to the
text, numbers or formulas need to be saved using the Save operation.

To Save a new Workbook:
» Choose File>>Save As from the menu bar.

Eile Edit Wieww Inserk Fo
M ChrlHM

L Open... Chrl+C

Close

= save Chrl+-5

| Save 4s... [

44y Save as Web Page. L’G

%1 File Search...

Choose the Save As command
when saving an Excel file for
the first time.

» The Save As Dialog Box appears.

» Click on the Save In: dropdown menu and locate where the file will be saved. Choose
the CD drive, or Floppy disk drive(A:) to save the file to a floppy disk or Local Disk
(C:) to save the file to your computer.

» Type a name for your file in the File Name: box.
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» Click the Save button.

@ <o Local Disk (C:) v @~ | @ X i 03~ Took~
y CNCOMPAD)|
J I Cpaapps

My Recent Cicpas
Documents ) Docurenks and Settings

= 1386
u LMy Downloads

Deskiop ) Program Files

) GUEKLING,
\ L WINDOWS
My Docurnénts
%8
Iy Compiuter
‘ o S
Ity Metwork e
Places Save a5 byDe! | Microsoft Office Excel Workbook b

To Save Changes Made to an Existing Workbook:
» Choose File>>Save from the menu batr,

> Or Click the = Save button on the Standard toolbar.

If you're saving the file for the first time and you do not choose a file name, Microsoft Excel will
assign a file name for you.

It is a good idea to Save frequently when working in a spreadsheet. Losing information is never
fun! You can quickly save your spreadsheet by using the quick-key combination Ctrl + S.
3.1.3 Opening a workbook

You can open any workbook that has previously been saved and given a name.

To Open an Existing Excel 2003 Workbook:
» Choose File>>Open from the menu bar.

Filz | Edit ‘Wiew Insert Fo

M, ChFl+M

5 open... o |
Close hy

= save ChrH-5
Save As
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> The Open dialog box opens.

<ee Local Disk (C:) | @ - Q) W T 3~ Tools
5 LI COMPAD
e CCpaapps
My Recent | Emffd
s (!
) Docurnents and Sektings Folder List
- ]
u )My Downloads
Desktop ) Prosgr am Files
T2 QUIKLINE
\ ) WINDOWS
My Docurnents
%8
Ity Computer
- v
My Netvaork,
Places Files of bype: | all Microsoft Office Excel Fles -

> Inthe Look in list, click the drive, folder, or Internet location that contains the file you
want to open.
> Inthe folder list, open the folder that contains the file. Once the file is displayed, click on
the file you want to open.
» Click the Open button.
3.1.4 Closing a Workbook

To close an existing Excel 2003 Workbook:
» Choose File = Close from the menu bar. The workbook in the Excel window is closed.

File | Edit Wiew Insert Fo

New... ChrlN

= EM. .. Chrl0
| Close

.
= Save N s

=

Excel 2003 will prompt you to save information if any has been typed between the last save and
the time you close the file

3.2 Entering, Creating and Editing Data

Entering Text in a Cell
You can enter three types of data in a cell: text, numbers, and formulas. Text is any entry that
is not a number or formula. Numbers are values used when making calculations. Formulas are
mathematical calculations.
To Enter Data into a Cell:

» Click the cell where you want to type information.
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» Type the data. An insertion point appears in the cell as the data is typed.

Sue 454 Street
To| | l=55 Street

Insertion point

> The data can be typed in either the cell or the Formula bar.

Text can be entered in the cell or in the Farmula bar.

FRWEN " | W A e
: Arial 10 - B U= = =|= 3
- X,-é A~ To
A | B I c I D I E I F I [E I
1 |First Name l-ast Name Address Phone
2 [Jahn Jones 123 Strest| 555-5555
3 |Jane Smith 345 Street|555-12354
4 |Joe Srmith A5G Strest|555-5673
5 [Tal” |
=)
7

» Data being typed appears in the both active cell and in the formula bar.

- | AR NN R AN AN A SN NN

i arial = = = | == i=
A [ E [ F [ G [

1 |First Name Last Name Ad{lress Phone
2 [John 123 Street 555-5555
3 |Jane 349 Street 555-1234
4 | Joe A58 Street 555-5573
5 |Td
B
7

Text appears in both active cell and in the Farmula Bar as it is typed.

> Notice the Cancel and Enter buttons in the formula bar.

Mame box Fomula bar
BE - M

“ /
Cancel button Enter button

> Click the Enter button ‘¥ to end the entry and turn off the formula bar buttons.
Excel's AutoComplete feature keeps track of previously-entered text. If the first few characters

you type in a cell match an existing entry in that column, Microsoft Excel fills in the remaining
characters for you.

Editing Information in a Cell

Information in a spreadsheet is likely to change over time. Information can be changed in either
of two ways.
Quick and Easy Method:

» Click the cell that contains the information to be changed.

» Type the new entry. The old entry is replaced by the new entry.
If the original entry is long and requires only a minor adjustment (in spelling, for example), then
you can directly edit the information in the cell.
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To Edit Information in a Cell:
Method 1: Direct Cell Editing

> Double-click on the cell that contains the information to be changed.
» The cell is opened for direct editing.

A | B | ¢ | D |
1 |First Name Last Name Address Phone
2 |John Jones 123 Street/555-5555
3 [Jane Srnith 345 Street 555-1234
4 |l IS mith 455 Street 555-5678

Double-click on the cell and edit information
directly in the cell

» Make the necessary corrections.

> Press Enter or click the Enter button on the Formula bar ‘¥ to complete the entry.
Method 2: Formula Bar Editing

e Click the cell that contains the information to be changed.
o Edit the entry in the formula bar.

E3 Microsoft Excel - Book1

A, B | ¢ 1~—0b | E | F | &6 =

1 |First Hame Last Name Address Phon

2 |John Jones 123 Street 555-5555 Edit information

3 |Jane Smith 345 Street 555-1234 in the Formula bar
| 4 [Joe !Smith 456 Street 555-5678

5

=] -
M 4 » M)\ Sheetl  Sheet? / Shest3 / |< >
Edit ML

Deleting Information in a Cell
To Delete Data that Already Appears in a Cell:

» Click the cell that contains the information to be deleted.
> Press the Delete key, or
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» Right-click and choose Clear Contents from the shortcut menu.

ES Mmicrosoft Excel - Book1

iE] Fle Edit Wiew Insert Format  Tools Data
R = P e . W A e

i Arial - 10 ~| B JF U |= =
A2 - B John
A B [ C 1 D

1 First Name Last Name Address Phone
"2 [Mohn . lione 173 Shrapt CEL CECS

3 |[Jane &b | Cub L1234

4 |Joe 8 copy leE7a

5
& | i% Paste

| Pacste Special, ..

g 1 Insert. ..

10 Delete. ..

11 | Clear Coptents I~

12 g
ﬁ' | Tmsert Commment

14 7 Eormat Cells...
% Pick From Drop-down List.. .

17 Add Wabch

18 | Creake Lisk...

19 -

=, Hyperink...
21 il Look Up...

To Delete Data Being Typed But Not Yet Added to the Cell:
» Cancel an entry by pressing the Escape key.
Performing Undo and Redo
Sometimes, you might do something to a spreadsheet that you didn't mean to do, like type the

wrong number in a cell. Excel 2003 allows you to undo an operation. Use the ~)_“Undo button
on the Standard toolbar to recover an error. The last single action is recoverable.
To Undo Recent Actions (typing, formatting, etc), One at a Time:

> Click the "* “Undo button.
To Undo Several Recent Actions at Once:

» Click the arrow next to the Undo button.
» Select the desired Undo operation(s) from the list.

E = \ = 3 |
i arial -0 - B X U= = Pl -
F=a - b Twping 'Donna’ in B9
Twping "Rick! in BS —
fa | E | c | [m | E Twping "Jessica' in BF I
1 Torm Twping 'Kathy' in B+
2 Eoh Clear
= T Select the Undo operation Twping 'Susan' in B&
ony from the Undo drop-down Tywping "Mary’ in BS
4 Kathy list. Twping 'Tina' in B4+
5 hary Twping "Torny' in B3
Twping ‘Bob' in B2
[=] Suss!n Typing 'Tom' in B1
7 Jdessica Clear
=] Tommy Twping ‘Tom' in &1
=) Donna Undo 1 Ackion
1o

> Microsoft Excel reverses the selected action and all actions that appear in the list above
it.
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An Undo operation can be cancelled by applying a Redo. This is useful when an Undo
operation was mistakenly applied. Remember, a Redo is possible only if you have not changed
an Excel spreadsheet since the last Undo operation was completed:

To Redo an Undo Operation:

> Press the © " Redo button.
To Redo several recent Undo actions at once:

» Click the arrow next to Redo button.
» Select the desired Redo operation from the list.
> Microsoft Excel reverses the Undo operation.

Selecting Multiple Cells

The currently-selected cell in Excel is called the active cell. You can also select a group of
adjacent cells, or a cell range. Many operations can be done against a cell range: move it,
copy, it, delete it or format it. A cell range can be defined in different ways: select a specific
range of cells, select multiple columns or rows, or select the entire worksheet.

To Select a Range of Cells:

> Move to the first cell in the range.

> The mouse pointer becomes a large cross.

> Click-and-hold the left mouse button and drag left or right, up or down to the last cell you
want to select.

» Release the mouse button.

> The cells you selected are shaded.

A, | E | ¢ | D E |
_1 |First Name Last Name Address Phone
_2 |daohn Jones 123 Street 555-5555
_3 |Mane Smith 345 Street 555-1234
4 |Joe Smith 456 Street 555-0675
5
B

To Select All Cells in a Column or Row:

> Click the gray Column heading to select the entire column. (Click and drag the cursor
across other column headings to select those columns).

E B [ Cc [ D |
First NamglLast Name Address FPhone

—

dahn Jones 123 Street 555-5555
Jane Smith 345 Street 555-1234
doe Smith 458 Street 555-5673

et il U D

Click on the gray column heading
to select the entire column.

> Click the gray Row heading to select the entire row. (Click and drag the cursor down
through the row headings select those rows).
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A | e | ¢ | o | E | F |
1 |First Name Last Name Address Phone
2 [John Jones 123 Street 555-5555
Jane Stith 345 Street 555-1234
4 |Joe Smmith 456 Street 555-5675
5

Click on the gray row heading to select the entire row.
To Select the Entire Worksheet:

» Click the gray rectangle in the upper left corner to select entire worksheet.

@_)l File Edit YWiew Insert Format  Tools  Data  indow

HRN=A" NEREIR= RN AR TEER: S AR

i prial -0 - B I U E=

I
s,
(!

J oA [ 8 [ ¢

L)
m

Jones 123 Street 555-5555
Smith 344 Street 555-1234
Smith 486 Street 555-5678

[ S A L S

Click on the gray rectangle to
select the entire worksheet.
If the cells and columns you want to select are not directly next to one another, select one of the

ranges you want to select, and hold down the Control key while selecting other ranges.

A, “ C “
1 [First Name Last Name Address
2 |John Jones 123 Street 555-5555
3 [Jane Smith 345 Street 555-1234
4 |loe Smith 456 Street 555-5678
5
=]
7

3.3 Moving, Copying and Deleting Cell Contents

Cut, Copy and Paste
Cut, Copy and Paste are very useful operations in Excel. You can quickly copy and/or cut
information in cells (text, numbers or formulas) and paste them into other cells. These
operations save you a lot of time from having to type and retype the same information.
The Cut, Copy and Paste buttons are located on the Standard toolbar.

Cut, Copy. and Paste Buttons on the Standard Toolbar

HRNEE" BERE 1= RN AN WEER R AR R

~ 1
Cut Copy FPaste
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The Cut, Copy and Paste operations also appear as choices in the Edit menu:

Edit | ¥iew Inserk  Faormal

=) Undo Clear  Crl+2
dh 0 Cut Zerl+
284 Copy Chrl+C
:fﬂg Office Clipboard. ..
[ Paste Chrl4Y
Paste Special, ..

The Cut, Copy and Paste operations can also be performed through shortcut keys:
Cut Ctrl+X
Copy Ctri+C
Paste Ctrl+Vv

Copy and Paste Cell Contents
The Copy feature allows you to copy selected information from the spreadsheet and temporarily
place it on the Clipboard, which is a temporary storage file in your computer's memory. The
Paste feature allows you to select any of the collected items on the Clipboard and paste it in a
cell of the same or different spreadsheet.
To Copy and Paste:

» Select a cell or cells to be duplicated.

> Click on the -2 Copy button on the standard toolbar.
» The border of the copied cell(s) takes on the appearance of marching ants.

E Microsoft Excel - Book?

I3|_1 File Edit ‘Wiew Insert  Formakt  Tools D

ARNE=N" RERE = REN AR =R

i arial -0 - B I U|=
B4 - & =SUM(B2-B3)
A | B | c© | D
; Sales 34567
3 |Expenses 1234
:51 E 33,333;

Marching ants appear during the copy process

» Click on the cell where you want to place the duplicated information. The cell will be
highlighted. If you are copying contents into more than one cell, click the first cell

where you want to place the duplicated information.
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E3 Microsoft Excel - Book2
E‘_W File Edit Miew Insert  Formak  Tools  Data  Windoe

ARNE=R" NEWE I RN AR RN RN RN
i Arial 10 | B I U|E=E =i

B5 - i

A [ B | ¢ [ b | E |
1
2 |Sales 24567
Click where the information
i E}{penses'___gé’l_g_g_;: will be pasted. Motice the
':-.i marching ants remain.

g !

» Press the Enter key. Your information is copied to the new location.
Be careful if you paste copied cell information into cells that already contain data. If you do, the
existing data is overwritten.

You can copy information from many different sources including Web sites, emails or other
Office applications like Word and PowerPoint and paste it into an Excel spreadsheet.

Cut and Paste Cell Contents
The Cut feature allows you to remove information from cells in the spreadsheet. Information that
is cut can be pasted in another cell, as long as the pasting occurs before you perform another
operation. If you don't paste the cut information immediately, it is removed from the Office
clipboard.
To Cut and Paste:

Select a cell or cells to be cut.

Click on the Cut 4. button on the Standard toolbar.

The information in the cell is deleted.

The border of the cut cell(s) take on the appearance of marching ants.

Click on the cell where you want to place the duplicated information. The cell will be
highlighted. If you want to paste the contents into more than one cell, click the first cell
where you want to place the duplicated information.

YV VYV

E3 Microsoft Excel - Book2

HET; I File Edit Wisn Inserk Faormak Tools Craka wWindow

ER N PN R = = N TR = | &
i Arial - 10 -~ | B F O |= = = | i

B5 - B2

A I E I [ I D I E I
1
2 |Sales 34567
Click where the information
i Expenses :---3§1-§-g-;: will be pasted. Motice the
: marching ants remain.

5 -
5

» Press the Enter key. Your information is pasted to the new location.
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You do not have to paste information that has been cut. You can use Cut to delete information
from a cell.

Moving Information Using Drag-and-Drop

Another way to move information from one cell to another is to use the drag-and-drop method.
You use the cursor to point to the information to be moved and then drag the cell to its new
location.

To Use Drag and Drop:

> Highlight and select the cell(s) you want to move to a new location.

> Position the mouse pointer near one of the outside edges of the selected cell(s). The
mouse pointer changes from a large, white cross and becomes a slender, black cross
with arrows at all ends.

A | B | ¢ | A | B | c© |
1 1
2 |Savings 2451 2 |Savings ., 2451
3 oo 3
4 Large, white cross 4 Slender, black cross
5 g with arrows at all ends

> Keep the mouse pointer on the outer edge of the selected cell, click and hold the left
mouse button and drag the cell(s) to a new location.

A | 8 [ ¢c [ b [ E |

Savings 245!

L\E': 505

> Release the mouse button to move the information to its new location.

3.4 Creating Simple Formulas

About Formulas

In school, you learned formulas used to calculate math problems. Microsoft Excel uses these
same formulas to perform calculations in a spreadsheet.

A formula can be a combination of values (hnumbers or cell references) and math operators (+, -,
/, *, =) into an algebraic expression. Excel requires every formula to begin with an equal sign
(=)

Creating a Simple Addition Formula

A simple formula in Excel contains one mathematical operation only: one number plus a second
number equals a third number. Writing a simple formula is really no more difficult than that: 1+1.
The only difference in Excel is that all formulas must begin with the equal sign (=). It is not
enough to type 1+1 in Excel because what will appear in the cell is "1+1." You must begin the
equation with an equal sign, or =1+1. This holds true for any formula, simple or complex, that
adds, subtracts, multiplies or divides.
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Let's add two numbers to create a third, 128+345=473. In Excel, this would be expressed by the
formula, =128+345, as shown below.

B2 - A =128+345
A | B | ¢ | D |
1
2 4?3.
3 The formula, =128+345,
4 |produces an answer of 473,

To Create a Simple Formula that Adds Two Numbers:

Click the cell where the formula will be defined.

Type the equal sign (=) to let Excel know a formula is being defined.

Type the first number to be added (128, for example)

Type the addition sign (+) to let Excel know that an add operation is to be performed.
Type the second number to be added (345, for example

Press Enter or click the Enter button on the Formula bar to complete the formula.

But what if a column contains many numbers, each of which regularly changes? You don't want
to write a new formula each time a number is changed. Luckily, Excel 2003 lets you include cell
references in formulas.

VVVVYVYVY

A formula can add the value of two cells-B2 and B3, for example. Type any two values in these
two cells and the formula will adjust the answer accordingly.

Using this method to calculate two numbers-128 and 345, for example-requires that you type
128 in cell B2, for example, and 345 in cell B3. The Excel formula, =B2+B3, would then be

defined in cell B4.

SUM ~ X o & =SUMEZ+ED)
o, I E I c I 5] I

|=SUmMEZ +E=)

MM ||k =

Type the

formula, =B2+B3, = I i I = I U I
in cell B4 and
press Enter to see
the result.

128

M| & |Wk|=
I
-~
]

To Create a Simple Formula that Adds the Contents of Two Cells:

» Type the numbers you want to calculate in separate cells (for example, type 128 in cell
B2 and 345 in cell B3).
Click the cell where the answer will appear (B4, for example).
Type the equal sign (=) to let Excel know a formula is being defined.
Type the cell number that contains the first number to be added (B2, for example).
Type the addition sign (+) to let Excel know that an add operation is to be performed.
Type the cell number that contains the first number to be added (B3, for example).

> Press Enter or click the Enter button on the Formula bar to complete the formula.
Creating a Simple Subtraction Formula Using the Point-and-Click Method

YV V V V V
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Formulas can be created by using either numbers or cell references in the definition. You can
also use the mouse to select the cells to be used in the formula instead of typing the cell
number or cell reference. Using this method, we are going to write a simple formula that
subtracts one cell from another: =B3-B2.

AVERAGE |+ X of & =B3-B2

A | B | ¢ | o | E |
; -'FF""TEFE—!? Formula =B3-B2 subtracts
e Iida = =
3 | 3451 cell B3 from cell BZ.
4 =B3-B2| |
ol
5
B

To Create a Simple Formula using the Point and Click Method:

» Type the numbers you want to calculate in separate cells (for example, type 128 in cell
B2 and 345 in cell B3).

Click the cell where the answer will appear (B4, for example).

Type the equal sign (=) to let Excel know a formula is being defined.

Click on the first cell to be included in the formula (B3, for example).

Type the subtraction sign (-) to let Excel know that a subtraction operation is to be
performed.

Click on the next cell in the formula (B2, for example).

If you include multiple cells in the formula, repeat steps 4 and 5 until the entire formula is
entered.

> Press Enter or click the Enter button on the Formula bar to complete the formula

Creating Simple Multiplication Formulas

Creating multiplication formulas is very similar to addition and subtraction formulas. To multiply
two cells the formula, B2 and B3, you would need to insert a multiplication operator * between
them, =B2*B3.

A

VVVYVY

\ 2%

B

Formula =B2*B3 multiplies

—BZ*E7 cell BZ by the cell B3

Ly
=
m

[ S L S

To Create a Simple Formula that Multiplies the Contents of Two Cells:
» Type the numbers you want to calculate in separate cells (for example, type 128 in cell
B2 and 345 in cell B3).
Click the cell where the answer will appear (B4, for example).
Type =
Click on the first cell to be included in the formula (B2, for example).

Type a mathematical operator (Ex: the multiplication symbol *). The operator displays
in the cell and Formula bar.

Click on the next cell in the formula (B3, for example).

YV V V V

Y
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> If you include multiple cells in the formula, repeat steps 4 and 5 until the entire formula is
entered.
> Press Enter or click the Enter button on the Formula bar to complete the formula.

Creating Simple Division Formulas

Creating division formulas is very similar to the addition, subtraction and multiplication formulas.
To divide the contents of cell B2 by cell B3, you would need to insert a division operator /
between them, =B2/B3.

To Create a Simple Formula that Divides One Cell by Another:

A B ¢ | b | E |
]
2 I R ?,EFJ Formula =B2/B3 divides cell
3 L 345) BZDbycell B3
4 [=B2/E3 |
5
B
» Type the numbers you want to calculate in separate cells (for example, type 128 in cell
B2 and 345 in cell B3).
> Click the cell where the answer will appear (B4, for example).
> Type the equal sign (=) to let Excel know a formula is being defined.
> Click on the first cell to be included in the formula (B2, for example).
» Type a mathematical operator (Ex: the division symbol /). The operator displays in the
cell and Formula bar.
> Click on the next cell in the formula (B3, for example).
> If you include multiple cells in the formula, repeat steps 4 and 5 until the entire formula is

entered.

> Very Important: Press Enter or click the Enter button on the Formula bar. This step
ends the formula.

3.5 Creating Complex Formula

Complex Formulas
Simple formulas have one mathematical operation. Complex formulas involve more than one
mathematical operation.

The order of mathematical operations is very important. If you enter a formula that contains
several operations--like adding, subtracting and dividing--Excel 2003 knows to work those
operations in a specific order. The order of operations is:

1. Operations enclosed in parenthesis

2. Exponential calculations (to the power of)

3. Multiplication and division, whichever comes first
4. Addition and subtraction, whichever comes first

Creating Complex Formulas

Excel 2003 automatically follows a standard order of operations in a complex formula. If you
want a certain portion of the formula to be calculated first, put it in parentheses.
If we wanted to add the contents of cell B2 and cell B3, for example, and then take that answer

and multiply it by the data in cell A4, then we would need to define the following formula:
=(B2+B3)*A4.
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SUmM + ¥ F & =(E2+B37A4
A B | C | D | E | F |
54
57|

|=£EIZ+EIB;_|*A,¢1| The formula =(B2+B3)*A4 first adds
T 128 and 345 and then multiplies

the answer by 97.

00 (00|~ | T | e | 0B —

Enter the numbers you want to calculate.

Click the cell where you want the formula result to appear.

Type the equal sign (=) to let Excel know a formula is being defined.

Type an open parenthesis, or (

Click on the first cell to be included in the formula (cell B2, for example).

Type the addition sign (+) to let Excel know that an add operation is to be performed.
Click on the second cell in the formula. The reference B3 displays where you want your
result.

End the B2+B3 operation by adding the close parenthesis, or)

Type the next mathematical operator, or the multiplication symbol (*) to let Excel know
that an multiply operation is to be performed.

» Click on the third cell to be included in the formula, cell A4.

> Very Important: Press Enter or click the Enter button v on the Formula bar. This step
ends the formula.

VVVYVYVYVYYY

\ 24

Try changing one of the values in the formula and watch the answer to the formula change.

Filling Formulas to Other Cells

Sometimes, you will write a formula that gets used a lot in different places of a worksheet. For
example, a spreadsheet may contain several columns of humbers. Each column will contain a
formula that adds all the numbers in it. You could write the formula several times, once in each
column. Or you could copy-and-paste it into each column. The fill formula method allows you
to copy a formula and fill it into many different consecutive cells at the same time.

The mouse pointer changes to a black crosshair when passed over the fill handle, or the square
box in the lower right corner of the cell.

BS - A =(BZ2+B3)"aa
A [ B | [ [ D [ E [ F
128
345
o7
[ A5oo 1]

The mouse pointer changes to

a black corsshair when passed
owver the fill handle.

Fill Handle

e e e R e [ TN B

To Use the Fill Handle to Copy a Formula to a Surrounding Cell:

» Click on the cell that contains the formula to be copied.
> Position the mouse pointer over the fill handle.

MS-Excel Learners Guide g4
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» Click and hold the left mouse button, and then drag the contents to the cell that's to
receive the fill formula.

» Release the mouse button.

» Select the Copy Cells option in the fill formula drop-down menu.

ES - A =(B2+B31°Ad
A |8 | ¢ | o | E | F | & | H |
128
345
o7
[ ase5T 0 0 ol

el
[E] copv e
Copy the formula in cell B5 and fill it £ Fill Eormatting Cnly

into cells C5, D5, and E5. € Fill without Formatting

=]

a2 om0 e | R —

The cell references in a formula are automatically updated when the formula is copied to other

cells in the spreadsheet.
You can also use copy and paste to copy a formula to other cells. Click next to learn more

about the copy and paste method.

Copy and Paste Formulas

The process to copy and paste a formula is identical to that process used to copy and paste
text.

To Copy and Paste a Formula:
» Select the cell that contains the formula to be copied.

> Click the =2 Copy button. Marching "ants" appear around the copied cell(s).

E Microsoft Excel - Book?

@_] File Edit Wiew Insert Formak Tools D

ARNERS BENE =R AN NN

E.ﬁ.rial = 10 '|BIH|§
B4 - A& =SUM(B2-B3)
A | B | ¢ | DO
1
2 |Sales 34567
3 |Expenses 1234
4 33,3334
5

farching ants appear during the copy process

» Select the cell where the copied formula is to be pasted.
» Press the Enter key. The formula is copied to the new location.

Revising Formulas
You can revise any formula that was previously written in a worksheet.
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To Revise a Formula using the Keyboard:

> Double-click the cell that contains the formula you want to revise.
» The cursor can now move left and right between the values in the formula in cell B5.

SLIM ~ X & & =B2+683
A, | B | C | D

Sales 34 567.00
Expenses 1.,234.001 35,124.00

=B2+E35

To replace cell B2 with cell C3 in your
formula, type C3 where B2 appears
and then delete BZ2.

Emmwmmhmm—x

11
> Make the necessary changes to the formula.
> Press the Enter key or click the Enter button to accept the new formula.

Creating an Absolute Reference

In earlier sections we saw how cell references in formulas automatically adjust to new locations
when the formula is pasted into different cells.

Sometimes, when you copy and paste a formula, you don't want one or more cell references to
change. Absolute reference solves this problem. Absolute cell references in a formula always
refer to the same cell or cell range in a formula. If a formula is copied to a different location, the
absolute reference remains the same.

An absolute reference is designated in the formula by the addition of a dollar sign ($). It can
precede the column reference or the row reference, or both. Examples of absolute referencing
include:

$AS$2 The column and the row do not change when copied.
A$2 The row does not change when copied.
$A2 The column does not change when copied.

To Create an Absolute Reference:

> Enter the numbers you want to calculate (e,g., 34,567 in cell B2 and 1,234 in cell B3).
» Then, create a simple formula (=B2+B3).

B5 - A =B2+B3
A | B | C | D | E |

1

2 |Sales 34 55700 4523400

3 |Expenses 1.234.00 21 ,543.00

4

g |35EHII1.EIIII_|

7

> To create an absolute reference in the formula just created, insert a $ value before the B
(column reference) and 2 (row reference) in the reference to B2 so the new formula
reads, (=$B$2+B3)
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SLrM > 2 F & =FB52+B3
A B | ¢ | D | E |

1
2 |Sales 24 567.00 45 234,00
3 |Expenses 1.234.00 21.,543.00
|
5 =5B52+E3 1
5 )
7 Insert a § value before the B and 2 to create
g an absolute column reference (5B) and
o absolute row reference ($2).
10

» Copy and Paste the formula to another adjacent cell. The formula now includes an
absolute reference to B2, (=$B$2+D3).

() - e =RBH2+D3

A B | | oD
1
2 |Sales 34 567.00 45 234.00
3 |Expenses 1.,234.00 21.543.00
F|
5 v _35.801.00} 56,110.00]
(=}
7 The pasted cell retains the absolute
=] reference to cell $B$2 while the second
=] reference has changed from B3 to D3,
10
11
12

3.6 Using Functions

Using Functions

A function is a pre-defined formula that helps perform common mathematical functions.
Functions save you the time of writing lengthy formulas. You could use an Excel function called
Average, for example, to quickly find the average of range of numbers. Or you could use the
Sum function to find the sum of a cell range. Excel 2003 contains many different functions.

Each function has a specific order, called syntax, which must be strictly followed for the function
to work correctly.

Syntax Order:

1. All functions begin with the = sign.

2. After the = sign define the function name (e.g., Sum).

3. One or more arguments-numbers, text or cell references-enclosed by parentheses. If
there is more than one argument, separate each by a comma.

An example of a function with one argument that adds a range of cells, B3 through B10:
p

~SUM(B3:B10)

eqgual sign  function name argJ:“ert
An example of a function with more than one argument that calculates the average of
numbers in a range of cells, B3 through B10, and C3 through C10:
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~AVG(B3:B10, C3:C10)

equal '&iign function name argument

Excel literally has hundreds of different functions to assist with your calculations. Building
formulas can be difficult and time-consuming. Excel's functions can save you a lot of time and
headaches.

Excel's Different Functions

There are many different functions in Excel 2003. Some of the more common functions include:

Statistical Functions:

» SUM - summation adds a range of cells together.

» AVERAGE - average calculates the average of a range of cells.
» COUNT - counts the number of chosen data in a range of cells.
> MAX - identifies the largest number in a range of cells.

> MIN - identifies the smallest number in a range of cells.

Financial Functions:

> Interest Rates
» Loan Payments
> Depreciation Amounts

Date and Time functions:

DATE - Converts a serial number to a day of the month

Day of Week

DAYS360 - Calculates the number of days between two dates based on a 360-day year
TIME - Returns the serial number of a particular time

HOUR - Converts a serial number to an hour

MINUTE - Converts a serial number to a minute

TODAY - Returns the serial number of today's date

MONTH - Converts a serial number to a month

YEAR - Converts a serial number to a year

VVVVYVYVYVYYVYY

You don't have to memorize the functions but should have an idea of what each can do for you.

Finding the Sum of a Range of Data
The AutoSum function allows you to create a formula that includes a cell range-many cells in a
column, for example, or many cells in a row.

TN RN N AR Y e A R NP

: Arial - 10 v|BIﬂ|§§§|§§£§|iﬁiﬁiﬁivlfﬁ\~
— F'.ul:l:uSur:l
B2 * = 128
A B | ¢ ] b | E—T F | & |
1
2
3 345 Highlight the range of numbers to be added
4 243 and click the AutoSum button in the
5 o7 standard tooclbar.
5] 187
| ]
7
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To Calculate the AutoSum of a Range of Data:

>

Type the numbers to be included in the formula in separate cells of column B (Ex: type
128 in cell B2, 345 in cell B3, 243 in cell B4, 97 in cell B5 and 187 cell B6).

Click on the first cell (B2) to be included in the formula.

Using the point-click-drag method, drag the mouse to define a cell range from cell B2
through cell B6.

On the Standard toolbar, click the Sum button.

The sum of the numbers is added to cell B7, or the cell immediately beneath the defined
range of numbers.

Notice the formula, =SUM(B2:B6), has been defined to cell B7.

BY - A& =SUM(BZ:BR)
A | B | ¢ [ D | E |
1
2 128
3 345 The AutoSum of cells B2
through BE is added to cell
4 243 BY. Motice the formula,
5 oy =SUM{B2:B6), defined in
G 187 cell BY.
i 1000
L |
&)

Finding the Average of a Range of Numbers

The Average function calculates the average of a range of numbers. The Average function can
be selected from the AutoSum drop-down menu.

To Calculate the Average of a Range of Data:

>

>
>

>

Type the numbers to be included in the formula in separate cells of column B (Ex: type
128 in cell B2, 345 in cell B3, 243 in cell B4, 97 in cell B5 and 187 cell B6).

Click on the first cell (B2) to be included in the formula.

Using the point-click-drag method, drag the mouse to define a cell range from cell B2
through cell B6.

On the Standard toolbar, click on the drop-down part of the AutoSum button. z -

Select the Average function from the drop-down Functions list.

HRNE=N" RSN RN A NN S RN SR - N AN RN |
i Arial 10 | B I U | == = |4 = | i3 ~ Sum
B2 - A& 126 | average | |
A, | B | c | D | E | F Caunt |
1
2 28 L
3 345 rlir
4 243 More Eunctions. ..
5 =
B 157
7

The average of the numbers is added to cell B7, or the cell immediately beneath the
defined range of numbers.
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> Notice the formula, =AVERAGE(B2:B6), has been defined to cell B7.

AN RERE IE= REN AR TR S A AR R

: arial -0 - B I U E = = |iE =
BY b  =AVERAGE(BZ.BR)
A | B | ¢ | D | E |
1
2 126 The Average of cells B2
3 345 through B6 is added to cell B7.
4 243
g g7| Motice the formula,
5 197 =AVERAGE(BZ:B6), defined
incell BT.
; I EEIIZI!

Accessing Excel 2003 Functions
To Access Other Functions in Excel:
» Using the point-click-drag method, select a cell range to be included in the formula.

» On the Standard toolbar, click on the drop-down part of the AutoSum button.

» If you don't see the function you want to use (Sum, Average, Count, Max, Min), display
additional functions by selecting More Functions.

IRN=A " RERENEREN AR Y-S A Ry S I Nl
i Arial -0 - B I U EEE|EE| G Surmn

B2 - B 128 fverage i

A | B | C | D | E | F Counk i
; Max
3 Min
4 More Functions. e,
5 Vg
5]
| |

7

» The Insert Function dialog box opens.
» There are three ways to locate a function in the Insert Function dialog box:
You can type a question in the Search for a function box and click GO, or

You can scroll through the alphabetical list of functions in the Select a function field, or
You can select a function category in the Select a category drop-down list and review the
corresponding function names in the Select a function field.
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Insert Function

Search For a Funckion;

Twpe a brief descripkion of what wou wvwant to do and then G0
click Go
O zeleck a category: | Dake & Time b

Seleck a Function:

DA TEVALLIE
Dy
DaYSIE0 Functions associated with the
HOLUR, Drate & Time category.

MIMUTE
MCMTH ~*

DATE(year,m-onl:h,day)

Returns the number that represents the dakte in Microsoft OFfice Excel
date-time code.

Help on Ehis Funckion [ (=] 4 ] [ Cancel ]

» Select the function you want to use and then click the OK button.
3.7 Print Management
Specify a print area
In Excel 2003 you can print an entire workbook, a worksheet, a cell range or a cell. Excel
defaults to printing the entire worksheet. But if you want to print only a certain area of a
spreadsheet then you can define a print area.

To Specify a Print Area:

» Choose View>>Page Break Preview from the menu bar.

» A reduced image of the chart is displayed on the screen.

» Click on one of four blue-colored borders and drag to highlight and select the area to
print.

» Choose File >>Print Area>>Set Print Area on the menu bar.

Only that area you defined in the print range will print when the worksheet is submitted to the
printer for printing
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Preview a page before printing

Excel 2003 provides a Print Preview capability that shows a smaller picture of the printed page
directly on the computer screen. Print Preview is a good way for you to review the formatting
and make sure the columns, rows and margins appear exactly where you want them.

To Print Preview:

» Choose File>>Print Preview on the menu bar,

> Or Click the Print Preview button on the standard toolbar.

> In Print Preview window, the document is sized so the entire page is visible on the
screen. Simply check the spreadsheet for overall formatting and layout.

The Zoom button in Print Preview will enlarge the data so it can be read.
Inserting and Removing a Page Break

There are two different kinds of page breaks in Excel: soft page breaks and hard page breaks. A
soft page break is automatically inserted into a spreadsheet when there is too much data to fit
on one page. A hard page break is one that you can insert into a spreadhseet, wherever you
want it to appear.

To Insert a Page Break:

> Move the cursor to the row where a page break needs to be inserted. This row will be
the first row on the new page.
» Choose Insert>>Page Break from the menu bar.
> A page break, indicated by a dashed line, is inserted into the worksheet.
To Delete a Page Break:

> Move the cursor to the row where a page break appears
» Choose Insert>>Remove Page Break from the menu bar.
> The page break (represented by a dashed line) is removed from the page.

Printing a Worksheet or Workbook

Printing in Excel is much like printing in other Office applications like Microsoft Word. As
previously mentioned, Excel defaults to printing the entire worksheet.

To Print a Worksheet:

» Choose File>>Print from the menu bar.

> The Print dialog box opens.

» Specify the Printer Name where the spreadsheet will print. If you only have one printer in
your home or office, Excel will default to that printer.

> In Print Range, choose whether to print All or a certain range of pages (Pages From n
to y, where n and y are the beginning and ending page numbers.

> In Print what, choose whether to print a Selection, the Active sheet or the Entire
Workbook (all worksheets in the workbook). Excel defaults to the Active Sheet.

» Choose the Number of Copies to print by clicking on the up or down arrows.

> Click the OK button to print the worksheet.

Don't print your Excel spreadsheet without checking spelling first! Excel includes two tools to
help correct spelling errors: AutoCorrect and Spelling.
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4. Worksheet Layout and Management
4.1 Working with Multiple Worksheets

Naming Worksheets

At the beginning of this course, we learned that the tabs displayed at the bottom of the screen
are named Sheetl, Sheet2 and Sheet3. These are not very informative names. Excel 2003
allows you to define a meaningful name for each worksheet in a workbook-Checkbook, Reports,
Accounts-so you can quickly locate information.
To Name a Worksheet:

> Double-click the sheet tab to select it. The text is highlighted by a black box.

16 "
M 4 » »Sheetl ; Sheetz { Shests /  |¢ 3l

Ready LM
» Type a new name for the worksheet.

16 | v
M 4 » W) Checkbook ; Sheet2 / Sheet3 |¢ >
Ready

10}

> Press the Enter key.

> The worksheet now assumes the descriptive name defined.
Inserting Worksheets
By default, each new workbook in Excel 2003 defaults to three worksheets named Sheetl,
Sheet2 and Sheet3. You have the ability to insert new worksheets if needed or delete others
you no longer want.
To Insert a New Worksheet:

» Choose Insert>>Worksheet from the menu bar.

Inserk Format Tools [mF]

Rowes

Columns

| worksheet |

I
!ﬂ —hark. .. L“‘S
e Function...
Mame »
Picture »
lt Hywperlink. .. CErl+-k

b3

» A new worksheet tab is added to the bottom of the screen. It will be named Sheet4,
Sheet5 or whatever the next sequential sheet number may be in the workbook.

Deleting Worksheets
Any worksheet can be deleted from a workbook, including those that have data in it.
Remember, a workbook must contain at least one worksheet.
To Delete One or More Worksheets:
> Click on the sheet(s) you want to delete.
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» Choose Edit >>Delete Sheet from the menu bar.

E )
=3
=

[

-

Edit Wisw

Inserk

Forrnak

—an't Unda Zkrl+Z

—an't Repeat Ckrl4

kb Zkrl+x

Copy ZErl4C
Office Clipboard. ..
Paskte CErl+Y
Paste Special. ..

FPaste as Hyperlink

Fill
Clear

Delete. ..

Delete Shest .

e g |

Move or Copy Sheet. Lﬁg

Find. .. Ckrl+F

Replace. .. ZErl+H

G0 Ta... Zkrl+a

Links...

objeck

» The following dialog box appears if the sheet being deleted contains information on it.

Microsoft Excel

! "_-., Daka may exisk in the sheek(s) selected For deletion. To permanently deleke the data, press Delete,

[ Delete ]

[ Cancel ]

» Click the Delete button to remove the worksheet and all the data in it.
Another way to delete or insert a worksheet is to right-click on the sheet to be deleted and then
select Delete or Insert from the shortcut menu.

40

41

42

43

44

45

45

47

43

Ready

Inserk...

Delete

i

Mowve or Copy...

Rename

Select All sheets

Tab Color. .,

G view Code

M 4 » #]y Sheetl / Sheet2 b Sheets 7

Grouping and Ungrouping Worksheets
A workbook is a multi-page Excel document that contains multiple worksheets. Sometimes
you will want to work with the worksheets one at a time as if each is a single unit. Other times,
the same information or formatting may need to be added to every worksheet. You can type and
retype the same information in each worksheet, or apply identical formatting, or you can group
the worksheet and enter the information once.
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Worksheets can also be combined together into a group. Grouping worksheets allows you to
apply identical formulas and/or formatting across all the worksheets in the group. When you
group worksheets, any changes made to one worksheet will also be changed in any other
worksheets in the group. If many worksheets are to have the same data--regions, departments,
guarters, months, weeks and days, for example--then you type it once and it will appear on
every worksheet included in the grouping.

A | B | ¢ | ©o [ E | F |
L1 January February |March April May
| 2 |Income A [ B [ o [ D [ E [ F [
| 3 | L1 January February |[March April May
| 4 |Rent | 2 |Income A [ B [ c
| 5 |Power | 3 | L1 January February Ma
| B |Cable 4 |Rent 2 |Income
| 7 |Phone E Power IER
| 8 | | B |Cable 4 |[Rent
| 9 |Food | 7 |Phone Zpower
| 10 |Gas | &8 | 6 [Cable
| 11 |Car Payment | 9 |Food ' 7 |Phone
| 12 |Misc. 10 |Gas 5]
15| | 11 |Car Payment ' 2 |Food
| 14 |Savings | 12 |Misc. E Gas
15 | 13 | | 11 |Car Payment
| 16 |Total Remaining | 14 |Savings 12 |Misc.
|17 | 15| EEl
Total Remaining | 14| Savings

|
i ]
-
JEY P
~m
—
m

v M Sheetl  Sheetz? / Sheet3

—
m

Total Remaining

<« » »fy Sheetl f Sheetz

=
@

4 » wly Sheetl Sheets /

=
=]

.
]

To Group Worksheets:

» To select one worksheet, click on the sheet tab.
> To select more than one worksheet, hold the Control key down and click on one or
more worksheet tabs in the workbook.
> To select all worksheets in a workbook, right-click on any worksheet tab and choose
Select All Sheets from the shortcut menu.
When finished entering, moving, copying or formatting the data, you will need to ungroup

worksheets. If you do not ungroup the sheets, any work you do in one sheet will be duplicated in
all the others.
To Ungroup Worksheets:

> Right-click on any of the selected worksheet tabs.
» Choose Ungroup Sheets from the shortcut menu.

Moving Worksheets
When you move a sheet, you are moving it to a new location in this or another workbook.
To Move a Workbook:

» Select the worksheet you want to move/copy.
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>
>

Choose Edit >>Move or Copy from the menu bar.

Edit Wien Inserk Forrmak
Can't Undao CErl+2
Can't Repeat CErl4-y
56 Cuk Chrl4-
=8 Copyw ZErl-C
|_-_‘°1= OfFfice Clipboard...
i Paste Chrl+y
Paste Special. ..
FPaste as Hyperlink
Fill »
Clear »
Delete. ..
Delete sheetk
| Mowe or Copy Sheet. ..
2% Eind... Ckrl+F
Replace. .. ZErl+H
o To... ZErl45
Links...
Dbjeck

In the Move or Copy dialog box, use the drop down boxes to select the name of the
workbook you will move the sheet to (the current workbook is the default). Also define
where you want the sheet positioned in the workbook.

Move or Copy EJ

Mowve selected sheets
To book:
Bookz w

Eefore sheet;

Sheet3
{move bo end)

|:| Creakte a copy

[ Ik ] [ Cancel ]

Check Create a copy to copy it.
Click the OK button to move the worksheet to its new location.

Copying Worksheets
When you copy a sheet, you make an exact copy of it.
To Copy a Worksheet:

>
>
>

Select the worksheet you want to move/copy.

Choose Edit>>Move or Copy from the menu bar.

In the Move or Copy dialog box, use the drop down boxes to select the name of the
workbook you will copy the sheet to (the current workbook is the default). Also define
where you want the sheet positioned in the workbook.




Move or Copy g|
Maove selected sheets

To book;

Book1 w

Before sheet:

Sheetz
Sheet3
(move bo end)

| ok

][ Cancel ]

» Click the Create a copy checkbox.

4.2 Inserting and Deleting Rows and Columns
Inserting a row

You can insert a row in a spreadsheet anywhere you need it. Excel moves the existing rows
down to make room for the new one.

To Insert a Row:

OR
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E @J Eil= Edit Wi Inserk Formak Tools Dakta imdon

) g b (3 g mows L9

: Arial - Columns & = = | =
o - worksheet e —

A | BB chat..

1 S Function...

2 |[Sales 534 54

3 |Expenses %127 Marne >

4 |Total Il 535 80 Picture »

5 -

5 B Hyperlink.., Cerl4k

7 | ¥ |

[

g Click in the row below where you want to insert

10 a new row and then choose Insert >> Rows

11 from the menu bar.

12

» A new row is inserted above the cell(s) you originally selected.
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» Click OK to create an exact copy of the worksheet and move it to the location specified.

» Click anywhere in the row below where you want to insert the new row.
» Choose Insert>>Rows from the menu bar.

» Click anywhere in the row below where you want to insert the new row.
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» Right-click and choose Insert from the shortcut menu.
A | E I c I 8] I E I
1
2 |Sales 534 567 .00
3 |Expenses| $1 234.00
4 [Total I$35:EID1. i |
5 # o Cuk
_B | =5 | Copy
il po
5 | I Paste
9 Faste Special. ..
% | Inserk... %
=0 Delete. ..
13 Clear Contents
% | Insert Comment
16 5 Format Cells...
% Pick From Drop-dowen Lisk. ..
19 Add wWakch
20 Creake Lisk. ..
% \,!_, Hywperlink. ..
23 ol LookUp...
24
» The Insert dialog box opens.
Inserk
) shift cells right
(1 Shift cells dowen
O} = i
(O E
I Cancel ]
» Choose the Entire Row radio button.
» Click the OK button.
» A new row is inserted above the cell(s) you originally selected.
A, [ B [ [ |
1
2 |[Sales 534 567 .00
3 |Expenses %1 23400
4
5 |Total $35 501 .DEI
=]
7 A blank row is inserted betweean
= roves 3 and 4.

Select multiple rows before choosing Insert to add rows quickly. Excel inserts the same number
of new rows that you originally selected.

Inserting a column
In Excel, you can insert a column anywhere you need it. Excel moves the existing columns to
make room for the new one.

To Insert a Column:
» Click anywhere in the column where you want to insert a new column.
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OR

» Choose Insert>> Columns from the menu bar.

E |E_1 Eile Edit Wisww Inserk Formak Tool=s Data Wi
P bl A ] Rows F | -
i Arial i Sefluine . = =
12 - Worksheet g
A L chart... D

1 Monthly Bills £ Function...

= Rent

3 Gas =T >

4 Electric Picture »

5 Grocieries .

=) Insurance =m| Hyperlink... ctri+k

7 Car Payment | £ |

=] Cable 35.00 35.00

=] Internet s0.00 s0.00

10 Credit Cards 55.00 155.00

11 Day care S500.00 S00.00

12 Gasoline 50.00 BEI.DD_

13 Misc. 250.00 200,00

14 Total 215500 232500

15

16 [ Menthly Wage 240000

17

15 Savings 245.00

19

> A new column is inserted to the left of the existing column.

> Click anywhere in the column where you want to insert a new column.
> Right-click and choose Insert from the shortcut menu.

E |E_1 Eile Edit Wi In=erk Formak Tool= Dakta Wtiricd o
R I = = N N T T e P T =N A S B
i arial - 10 - | B 5 DO|== =|:=
() -~ A~ B0
A, [ [=] | = [ 5] [ E
1 Monthly Bills Januany March
2 Rent S00.00 S00.00
] Gas A45.00 55 .00
g Electric 50.00 =01 e
= Grocieries 130.00 g6 | Cut
B Insurance 110.00 = Copw
7 Car Payment 250.00 o
& Cable 35.00 5% paste
=] Internet S50.00 Paste Special. ..
10 Credit Cards 55.00 | Insert...
11 Day care s00.00 L
12 Gasoline 50.00 E=l=ES00.
13 Misc. 250.00 Clear Contenks
14 Total 215500, 2
15 —d  Inmsert Comment
16 Monthly Waage 2.400.00 ZE | Eormat Cells. ..
17 Fick From Drop-doven Lisk. ..
15 Savings 245 .00
19 Aadd watkch
=0 Create List...
g; 5;_?_5, Hyperlink. ..
23 G2 Lookup...
24
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» The Insert dialog box opens.

Insert
() Shift cells right
() shift cells down

{:} Enkire row

[ [0]4 ] [ Cancel ]

» Click the Entire Column radio button in the Insert dialog box.
» Click the OK button.
» A new column is inserted to the left of the existing column.

A, | B c | D
1 Monthly Bills | January March
2 Rent BOO.00 BOO.00
3 Gas 45.00 55.00
4 Electric 50.00 &0.00
5 Grocieries 130.00 15EI.EIEI
) Insurance 110.00 110.00
7 | Car Payment 250.00 250.00
i Cable 35.00 35.00
9 Internet 50.00 50.00
10| Credit Cards 55.00 155.00
11 Day care 500.00 500.00
12 Gasoline 20.00 B0.00
13 Misc. 250.00 300.00
14 Total 2,155.00 2.325.00
15 A new column is inserted
16 | Monthly Wage 2. 400.00 between the January and
17 March columns.
18 Savings 245.00
19

You can also select multiple columns before choosing Insert to add columns quickly. Excel

inserts the same number of new columns that you originally selected.

Deleting columns and rows

Columns and rows are deleted in much the same manner as inserting columns and rows.

To Delete a Row and All Information in It:

> Select a cell in the row to be deleted.
» Choose Edit>>Delete from the menu bar.
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> Click the Entire Row radio button in the Delete dialog box.

> Click the OK button.

To Delete a Column and All Information in it:
> Select a cell in the column to be deleted.
» Choose Edit>>Delete from the menu bar.
» Click the Entire Column radio button in the Delete dialog box.

o | E | ¢ | o |
1 Monthly Bills January March
2 Rent B00.00 B00.00
3 Gas 45.00 5500
4 Electric | S0.00 B0.00
5 Grocieries 130.00 150.00
b Insurai !
7| car Py )
g Cablq rojete
J Intern}  ~ opiee coiis fert
1d Credit C (2 shift cells up
11 Day cay .
12 Gasolij @ v
13 Miscy O Entire colurmn
14 Tota
15 [ [0]'4 ] [ Cancel
16 | Monthly Vererge =
17
15 Savings 245.00
19

> Click the OK button.

4.3 Changing Column Width and Row Height

Adjusting column widths

A, | E | [ | D | E |
1 Monthly Bills January March
2 Rent E00.00 E00.00
3 Gas 4500 55.00
4 Electric S0.00 G0.00
5 Grocieries 130.00 150.00
=) Insurance 110.00 110.00
7 Car Payment 250.00 250.00
=] Cable ]
9 Internet Dglete El
10 Credit Cards Celete
11 Day care ) shift cells left
12 Gasoline ) shift cells up
13 Misc.
14 Total g} # ERiE
15 ®E
1? Monthly Wage 2, [ o ] [ _— ]
158 Savings rriiopn )
19

By default, Excel's columns are 8.43 characters wide, but each individual column can be
enlarged to 240 characters wide.
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If the data being

entered in a cell is wider or narrower than the default column width, you can

adjust the column width so it is wide enough to contain the data.

B2 - = 12345675
A, | B | ¢ | D |

1 Monthly Bills | Janua March
2 Rent I##ﬁﬁ##! BO0O.00
3 Gas 45.00 55.00
4 Electric This example shows a case
L Grocieries where the number entered
B Insurance g:jﬁﬁ!ll“?i;dsﬂl_‘a.\rger than the
7 | CarPayment | ___.__  ___._.
g Cable 35.00 35.00

You can adjust column width manually or use AutoFit.

To Manually Adjust a Column Width:

» Place your mouse pointer to the right side of the gray column header.
» The mouse pointer changes to the adjustment tool (double-headed arrow).

A | 8 & ¢ | D | E |

1 Monthly Bills | January M?rnd:\

2 Rent BOO.OD|  BOO.OO

3 GGas 45.00 &5.00 Trl';lﬁenlgeo: ?g ﬁgmer

4 Electic | 5000 6000 SNE

5 | Grocieries | 130.00  fsggp ustmentteol

b Insurance 110.00 110.00

» Drag the Adjustment tool left or right to the desired width and release the mouse button.

A | E | ¢ |

1 Monthly Bills January March

2 Rent B00.00 BOO.00

3 Gas 45.00 £5.00

4 Electric ! 50.00 B0.00

5 Grocieries 130,00 150.00

b Insurance 110.00 110.00

7 | Car Payment 250.00 250.00

& Cable

g Internet Motice the difference in the

101 Credit Cards width of columns B and C.

11 MNav rara

To AutoFit the Column Width:

» Place your mouse pointer to the right side of the column header.
» The mouse pointer changes to the adjustment tool (double-headed arrow).
» Double-click the column header border.
» Excel "AutoFits" the column, making the entire column slightly larger than the largest
entry contained in it.
To access AutoFit from the menu bar, choose Format>>Column>>AutoFit Selection.

Adjusting row height
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Changing the row height is very much like adjusting a column width. There will be times when
you want to enlarge a row to visually provide some space between it and another row above or
below it.

To Adjust Row Height of a Single Row:

> Place your mouse pointer to the lower edge of the row heading you want to adjust.
» The mouse pointer changes to the adjustment tool (double-headed arrow).

A E | C |
Monthly Bills January March
Rent EO0.00 EO0.00
Gas 45,00 55.00
Electric 0.00 BO.00
Grocieries 13]).00 150.00

A 4 Csnm 440 mm

Insurance
Car Payment

The mouse pointer changes to

ammwmmbmm—x

Cable the Adjusiment tool.
Internet s e
Credit Cards 55.00 155.00
> Drag the Adjustment tool up or down to the desired height and release the mouse
button.
A E | ¢ |
1 Monthly Bills 1 January March
2 Rent FO0.00 G00.00
i Gas 4500 5500
4 Electric 50.00 B0.00
5 Grocieries R e
b Insurance Notice the dif _
S otice the difference in

7 | Car Payment height between row 1
g Cable and the other rows in
g Internet the spreadsheet.
10| Credit Cards

To AutoFit the Row Height:

> Place your mouse pointer to the lower edge of the row heading you want to adjust.
» The mouse pointer changes to the adjustment tool (double-headed arrow).
> Double-click to adjust the row height to "AutoFit" the font size.
» Excel 2003 "AutoFits" the row, making the entire row slightly larger than the largest entry
contained in the row.
4.4 Inserting and Deleting Cells

Inserting a cell
When working in an Excel 2003 worksheet, you may need to insert or delete cells without
inserting or deleting entire rows or columns.

To Insert Cells:

» Select the location where the new cell(s) should be inserted. It can be a single cell or a
range of cells.
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» Right-click and choose Insert.

Note: You could also choose Insert>>Cell on the menu bar.
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Y V VYV

Insert E|
Inserk

() shift cells right

o

'l:'}' Enkire rows

) Entire column
I Ok ] [ Cancel ]

n=ert dialog box

The Insert dialog box opens. Select either:
Shift cells right to shift cells in the same row to the right.
Shift cells down to shift selected cells and all cells in the column below it downward.

» Choose an option and click the OK button.
» Your result displays in the spreadsheet.

A | B | ¢ | D |

1

2

3 Sales 34 567.00

4 Expenses  1.234.00

5 ,I |

5] Inserted 35,801.00

7 Cell

g

A | B | C | o | E | F |

1
=
3 Sales 34 . 567.00
4 Expenses 1.234.00
5 35,8017 A0
B 45 Cub
i =3 Copy
g i3 Paste
10 Right-click on the cell {C5) Paste Special. ..
11 where the new cell is to be

inserted. Inserk... [
12 Lo
13| Click the Insert option in Delete. ..
14 the drop-down menu. Clear Contents
::g —d Insert Comment
1F S0 Format Cells.. .
1 g Pick From Drop-dowsn Lisk. ..
2':' Add ﬂatch
21 Create Lisk. ..
gg i, Hypetlink...
24 £ Lookup...
25

Remember, you can also use the Insert dialog box to insert or delete columns and rows.
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Deleting a Cell

To Physically Delete the Cell from the Spreadsheet:
» Right-click and choose Delete.

A, [ B [ = | D [ E [ F |

1
2

3 Sales 34 5657 .00

4 Expenses 1,234 .00
_5 |
B |

7 3I5.801.00 & | <ot
_8 | =3 | Copy

10 5%, Paste

11 FPaste Special...
% Inserk. ..

14 | Delete. .. o

15 Clear Contents 3

165

17 —d Insert Commenk
18 | 5 Format Cells...
% Pick From Drop-down List., ..

21 Creake Lisk...

22 L Hyperlink. ..

23 ;

24 A Lockup...

25

» The Delete dialog box opens. Select either:
» Shift cells left to shift cells in the same row to the left.

» Shift cells up to shift selected cells and all cells in the column above it upward.

() Entire row
() Entire column

Cancel

Lok JI

]

» Choose an option and click the OK button.
» Your result displays in your spreadsheet.

A | B [ | O | E |

1
2
3 Sales 24 567 .00
4 Expenses 1.234.00
5
5]
E 35.801.00
g Delete E|
10 v delet Delete
1; |1?ul-ljtiféﬁel‘<_ra1I cjlg gt the {:}fh'ﬂ: cells Ieff

same time. @ i
13
14
15
16
17
12
19
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Merging cells

In Excel 2003, you have another alignment option available to you: merge and center. This is
performed when you want to select one or more cells and merge them into a larger cell. The
contents will be centered across the new merged cell.

The picture below shows why we might want to merge two cells. The spreadsheet presents Last
Month and This Month Sales and Expenses for Sally. Notice that Sally's name appears above
the Last Month column. To evenly center Sally's name across the two cells we would perform a

merge and center.

A | B | C | D | E [ F |
1 Sally We would like to
2 Last Month This Manth see Sally's name
3 Sales 34,567.00 3256400 CEpiEred over bolh
4 Expenses 1.,234.00 3.,251.00
5
B
7 35801.00 3581500
g
g
To Merge Two Cells Into One:

» Select the cells that you want to merge. It can be cells in a column, row or both columns

and rows.

> Click the 22 Merge and Center button on the standard toolbar.

N I = = =N = T [ [ TS = e =
i Arial -0 - | B 7 U == == A
=1 - A Sally )
o | B c | O EW
1 Sally Highlight the cells to be
= Last MMonth This Maonth merged and then click the
3 Cales 34 S57.00 32 564.00 Merge and Center button
: : : : on the standard toolbar.
4 Expenses 1.,234.00 3.251.00
5 If you do not see the button,
= select the downrnward pointing
armmow at the end of the
il 35,801.00 35,815.00 toolbar to view the buttons
=] that may not be visible. Select
=] Add/Remowve buitons.
» The two cells are now merged into one.
A | B c | D E
1 oally 1
2 Last Maonth | This Maonth
3 Sales 34 567,00 32564.00
4 Expenses 1.234.00 3.251.00
5
B
7 35,0801.00 3581500
8

4.5 Text and Cell Alignments

Using the Standard Toolbar to Align Text and Numbers in Cells
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You've probably noticed by now that Excel 2003 left-aligns text (labels) and right-aligns
numbers (values). This makes data easier to read.

A B | C | D
1
2
3 Sales 34 567 .00
4 Expenses 1234.00
5 | |
5] Text, by default, is Mumbers, by default,
7 left-aligned in are right-aligned in
a Excel 2003. Excel 2003.

You do not have to leave the defaults. Text and numbers can be defined as left-aligned, right-
aligned or centered in Excel 2003. The picture below shows the difference between these
alignment types when applied to labels.

right-aligned text
left-aligned text

centered text

Text and numbers may be aligned using the left-align, center and right-align buttons of the

Formatting toolbar:
Merge and Center

ﬁ

N
Right-align
er

Left-align

To Align Text or Numbers in a Cell:

» Select a cell or range of cells
> Click on either the Left-Align, Center or Right-Align buttons in the standard toolbar.
> The text or numbers in the cell(s) take on the selected alignment treatment.

Changing Horizontal Cell Alignment

We've previously seen how to align text or numbers using the left-align, center and right-align
buttons in the standard toolbar. You can also define alignment in the Alignment tab of the
Format Cells dialog box.

A | B | > | D |
1
2
3
4
S
5 [Horizontal Alignment  Horizontal Left Horizontal Center Harizontal Right
3]

The Horizontal section features a drop-down that contains the same left, center, and right
alignment options in the picture above and several more:
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Fill

"Fills" the cell with the current contents by repeating the contents for the width of the cell.

Justify

> If the text is larger than the cell width, Justify wraps the text in the cell and adjusts the
spacing within each line so that all lines are as wide as the cell.

Center Across Selection

Contents of the cell furthest to the left are centered across the selection of cells. Similar to
merge and center, except the cells are not merged.

To Change Horizontal Alignment using the Format Cells Dialog Box:

» Select a cell or range of cells.
» Choose Format>>Cells from the menu bar.

] File  Edit Wiew  Insert

Foarmak Tool=s

Daka Wtimdions Help

RN W= W Nre W N
i arial - 10 - B b=
AT - A Zolumn »
o | E Sheet 3 | E |
; autoFormak. ..
Zonditional Formatking. ..

Sales Skyle. .. o6, 00
4 Expenses 1.234.00 3.251.00
5
=)
7 35.,801.00 35,815.00
5]

(You could also right-click and choose Format Cells from the shortcut menu.)

» The Format Cells dialog box opens.

» Click the Alignment tab.

Format Cells

ont

Text abgriment
Horizontal:

Text control
[ wrap text
[ shrink to Fit

[[] merge cells
Right-to-left

Text direction:

Conkext b

General e
Yertical:
Eottom ~

Border

Patterns

ied[ed

Probeckion

Crienkation

TR Do

Degrees

Ol

| [ Cancel

» Click the Horizontal drop-down menu and select a horizontal alignment treatment.
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> Click OK to apply the horizontal alignment to the selected cell(s).
Changing Vertical Cell Alignment
You can also define vertical alignment in a cell, similar to how it is done for horizontal alignment.
In Vertical alignment, information in a cell can be located at the top of the cell, middle of the
cell or bottom of the cell. The default is bottom.

A | B | c | D |

1

2 Some examples of Vertical Alignment of information in a cell.

]

Fl

“Fertical Justify
“ertical Center
5 |“Wertical Alignment ““ertical Bottom
B

To Change Vertical Alignment using the Format Cells Dialog Box:

Select a cell or range of cells.

Choose Format>>Cells from the menu bar.

Or (You could also right-click and choose Format Cells from the shortcut menu.)
The Format Cells dialog box opens.

Click the Alignment tab.

Click the Vertical drop-down menu and select a vertical alignment treatment.
Click OK to apply the vertical alignment to the selected cell(s).

Changing Text Control
Text Control allows you to control the way Excel 2003 presents information in a cell. There are
three types of Text control: Wrapped Text, Shrink-to-Fit and Merge Cells.

YVVVYVYVYVYVYVYYY

A | =] [ [

1
= Text Control Examples:
3
4

This is an

example of Wrapped Text Example
5 [wrapped text.
=]
¥ | =hrink v fiv cxample Shrink-to-fit Example
a
=]

> The Wrapped Text wraps the contents of a cell across several lines if it's too large than
the column width. It increases the height of the cell as well.

» Shrink-to-Fit shrinks the text so it fits into the cell; the more text in the cell the smaller it
will appear in the cell.

> Merge Cells can also be applied by using the 22 Merge and Center button on the
standard toolbar.

To Change Text Control using the Format Cells Dialog Box:

Select a cell or range of cells.

Choose Format>>Cells from the menu bar.
The Format Cells dialog box opens.

Click the Alignment tab.

YV VY
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» Click on either the Wrapped Text, Shrink-to-Fit or Merge Cells check boxes-or any
combination of them-as needed.
> Click the OK button.

Changing Text Orientation
The fourth type of cell alignment in the Format Cells dialog box is Text Orientation, which
allows text to be oriented 90 degrees in either direction up or down.
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= Text oriented at O Degrees (by default).
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1= Text Orientation Examples
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To Change Text Orientation using the Format Cells Dialog Box:

Select a cell or cell range to be subject to text control alignment.

Choose Format>>Cells from the menu bar.

The Format Cells dialog box opens.

Click the Alignment tab.

Increase or decrease the number shown in the Degrees field or spin box.
Click the OK button.
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4.6 Formatting Numbers
Formatting Numbers in the Format Cells Dialog Box
Numbers in Excel can assume many different formats: Date, Time, Percentage or Decimals.

To Format the Appearance of Numbers in a Cell:

Select a cell or range of cells.

Choose Format>>Cells from the menu bar.

Or You could also right-click and choose Format Cells from the shortcut menu.

The Format Cells dialog box opens.

Click the Number tab.

Click Number in the Category drop-down list.

Use the Decimal places scroll bar to select the number of decimal places (e.g., 2 would

display 13.50, 3 would display 13.500).

Click the Use 1000 Separator box if you want commas (1,000) inserted in the number.
> Use the Negative numbers drop-down list to indicate how numbers less than zero are

to be displayed.

» Click the OK button.

Formatting Date in the Format Cells Dialog Box

Date can be formatted in many different ways in Excel 2003.
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To Format the Appearance of a Date in a Cell:
» Select a cell or range of cells.
» Choose Format>>Cells from the menu bar.
> The Format Cells dialog box opens.
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» Click the Number tab.

> Click Date in the Category drop-down list.

» Select the desired date format from the Type drop-down list.
» Click the OK button.

4.7 Applying Font, Color and Border to Cells

Change font type, size and color

In Excel 2003 a font consists of three elements: Typeface, or the style of the letter; Size of the
letter; and Color of the letter. The default font in a spreadsheet is Arial 10 points, but the
typeface and size can be changed easily.

Selecting a Font Typeface:

The amount of typefaces available for use varies depending on the software installed on your
computer.

To Apply a Typeface to Information in a Cell:

» Select a cell or range of cells.

> Click on the down arrow to the right of the Font Name list box on the Formatting toolbar.
> A drop-down list of available fonts appears.

> Click on the Typeface of your choice.

> The selection list closes and the new font is applied to the selected cells.

To Apply a Font Size to Information in a Cell:

The "Font Size" list varies from typeface to typeface. The Arial font sizes, for example, are 8, 9,
10, 11, 12, 14, 16, 18, 20, 22, 24, 26, 28, 36, 48, 72.

Select a cell or range of cells.
Click on the down arrow to the right of the font size list box on the Formatting toolbar.
A drop down list of available font sizes appears.

Click on the Font Size of your choice.
The selection list closes and the new font size is applied to the selected cells.
pply Color to Information in Cells:

Select a cell or range of cells.

Click on the down arrow to the right of the font color list box.

A drop-down list of available colors appear.

Click on the color of your choice.

The selection list closes and the new font color is applied to the selected cells.
Underline, italics and bold

In addition to the typeface, size and color, you can also apply Bold, italics, and/or underline font

style attributes to any text or numbers in cells.

To
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To Select a Font Style:

Select a cell or range of cells.

Click on any of the following options on the Formatting toolbar.

Bold button (Ctrl + B).

Italics button (Ctrl + I).

Underline button (Ctrl + U).

The attribute(s) selected (bold, italics, or underline) are applied to the font.

VVVVYVYVYVYYVY
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The Bold, ltalics, and Underline buttons on the Formatting toolbar are like toggle switches. Click
once to turn it on, click again to turn it off.

Design and apply styles

Styles can save a lot of time when formatting a spreadsheet. A Style is a unique collection of
font attributes (Number, Alignment, Font, Border, Patterns and Protection). Many different styles
can be created in a spreadsheet, each with different attributes and names. When applied to a
cell, information in it resembles the attributes defined for that style.

To Apply a style:

» Select the cell or range of cells.
» Choose Format >>Style from the menu bar.
» Select a style from the Style name drop-down list.

You can change the style attributes (Number, Alignment, Font, Border, Patterns and Protection)
for any Style Name.
You can create new styles by clicking on the Add button in the Style dialog box.

Adding a border to cells
Borders can be applied to cells in your worksheet in order to emphasize important data or
assign names to columns or rows.

To Add a Border to a Cell or Cell Range:

» Select a cell or range of cells.

» Click on the down arrow next to the Borders button.

> The Border drop-down appears.

» Choose a borderline style from the Border drop-down menu.
» The selected cells display the chosen border.

Adding Color to Cells
Colors can be applied to cells in your worksheet in order to emphasize important data or assign
names to columns or rows.

To Add Color to a Cell:

» Select a cell or range of cells.

» Click the down arrow next to the Fill Color button. A Fill Color drop-down menu
displays.

» Choose afill color from the Fill Color drop-down menu.

> The selected cells display the color.
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5. Printing and Page Setup

5.1 Creating a Chart
Understanding the Different Chart Types

Excel 2003 allows you to create many different kinds of charts.

Area Chart
An area chart emphasizes the trend of each value over time. An area chart also shows the
relationship of parts to a whole.
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Column Chart
A column chart uses vertical bars or columns to display values over different categories. They
are excellent at showing variations in value over time.
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Bar Chart
A bar chart is similar to a column chart except these use horizontal instead of vertical bars. Like
the column chart, the bar chart shows variations in value over time.
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Line Chart
A line chart shows trends and variations in data over time. A line chart displays a series of
points that are connected over time.
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Pie Chart

A pie chart displays the contribution of each value to the total. Pie charts are a very effective
way to display information when you want to represent different parts of the whole, or the
percentages of a total.
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Other Charts
Other charts that can be created in Excel 2003 include: Doughnut; Stock XY (scatter);
Bubble; Radar; Surface; or Cone, Cylinder, and Pyramid charts.

Identifying the Parts of a Chart

Have you ever read something you didn't fully understand but when you saw a chart or graph,
the concept became clear and understandable? Charts are a visual representation of data in a
worksheet. Charts make it easy to see comparisons, patterns, and trends in the data.
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Source Data

The range of cells that make up a chart. The chart is updated automatically whenever the
information in these cells change.
Title

The title of the chart.

Legend

The chart key, which identifies each color on the chart represents.

Axis

The vertical and horizontal parts of a chart. The vertical axis is often referred to as the Y axis,
and the horizontal axis is referred to as the X axis.

Data Series
The actual charted values, usually rows or columns of the source data.
Value Axis

The axis that represents the values or units of the source data.
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Category Axis
The axis identifying each data series.

Creating a Chart Using the Chart Toolbar
» Charts can be created in a number of ways in Excel 2003. The quickest way to create
and edit your charts is to use the Chart Toolbar.

To Show the Chart Toolbar:
» Choose View>>Toolbars>> Chart on the menu bar.

Parts of the Chart Toolbar:
Chart Type gy Row

Format By Column

Chart Area -ﬁ*|ﬂv|:ﬁ|g| W
Legend Angle
Chart Objects List Box Data Table Text

Chart Objects List Box
This list box lets you select different parts of a chart for editing.

Format Chart Area

Used to format that part of the chart which is currently selected.

Chart Type

A drop-down menu that lets you select different types of charts. The chart type can be changed
at any time.

Legend

Used to show or hide the chart legend.
Data Table

Used to show or hide the actual Source Data used to create the chart.
By Row

Plots the Data Series using the row labels (Y-axis).

By Column

Plots the Data Series using the column labels (X-axis).

Angle Text

Use to rotate the angle of the X-axis and Y-axis labels.

Creating an Embedded Chart

Charts can be created in either of two ways in Excel 2003: Embedded Charts and a Chart
Sheet. Excel creates an embedded chart by default. An embedded chart is placed on the
same worksheet as the source data used to create it.
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To Embed a Chart in a Worksheet:

>
>

>

Choose View >>Toolbars>> Chart on the menu bar.

Select the range of cells that you want to chart. Your source data should include at least
three categories or numbers.

Click the chart type pull down on the chart toolbar and select the chart that you would
like to use.

Open the chart options dialog box: Chart>>Options to add a title to your chart.

Select the Titles tab and type the title of the chart in the Chart Title text box.
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Different charts work best with different data. A pie chart, for example, can only display one data
series at a time.

Excel 2003 includes a 4-step Chart Wizard that you can use to guide you through the steps for
creating a chart. Highlight the cell range you want to chart, choose Insert -+ Chart on the menu
bar and follow the instructions in the wizard.

Creating a chart sheet

Sometimes, you may want to create a chart and place it on a separate sheet in the workbook.
This is called a Chart Sheet. Chart sheets can make your charts stand out, particularly when
working with complicated spreadsheets.

To Move an Embedded Chart to a Chart Sheet:

YV VY

Create an embedded chart.

Select the chart to be moved to a chart sheet.

Choose Chart >>Location from the menu bar.

In the Chart Location dialog box, select the As a new sheet radio button.

(The As object in radio button adds the chart as an embedded object on the
worksheet.)

Click the OK button. The chart is displayed on a separate Chart Sheet in the Workbook.
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You can also use the Chart Location dialog box to rename the Chart Sheet.

5.2 Moving, Resizing, and Deleting Charts

Moving a chart
An embedded chart can be moved anywhere on a worksheet. The easiest way to move a chart
is to drag it around the worksheet.

To Move a Chart:

» Click anywhere on the white space in the chart and use the cursor to drag the chart
anywhere on the worksheet.

> Release the mouse button to place the graph in its new location.

Resizing a Chart

Charts can be resized-made larger or smaller-to fit on a worksheet. Chart Titles are sized in
proportion to how large or small you make the chart. And within the Chart Area, the Legend
and/or Plot Area can be made larger or smaller. Chart Titles can be moved but not resized.

To Resize a Chart:

» Click anywhere on the white space of the chart area, plot area or legend you want to
move or resize.

> Point the mouse to one of the Grab Handles or Resize Cursor-the pointer changes to a
double-headed arrow-to resize the chart.

> Use the mouse to drag the sizing handle until the chart is resized to the desired size.

Deleting a Chart

Any embedded chart or chart sheet can be deleted from a worksheet. A chart sheet is deleted
in the same manner a worksheet is deleted. This section discusses how to delete an embedded
chart.

To Delete a Chart:

> Click anywhere on the white space of the chart area to select the chart.
> Press the Delete key on your keyboard.

If you have difficulty deleting a chart, click anywhere outside of the chart and then select the
chart again.

5.3 Editing Charts
Changing Chart Data

When you add a chart to your worksheet, Excel creates a link between the chart and your
source data. Any changes made to the original source data are automatically reflected in the
chart.
To Change Chart Values Directly in Worksheet Cells:
» Open the worksheet that contains the chart to be changed.
» Click in the cell whose value will change and type the new value.
> Press Enter to accept the new value.
Changing the Chart Title
The Chart Title can be changed at any time to a hame that's meaningful to you.
To Change the Chart Title on the Chart:
» Click on the Chart Title.
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> Click anywhere in the title name and make any changes to the text.

> Click anywhere outside of the title to apply your changes.
Changing the Data Series Names or Legend Text
Data Series Names and Legend Text are changed in much the same manner as when you
changed Chart Values in the worksheet.
To Change the Data Series Names or Legend Text on the Worksheet:

» Click the cell that contains the Data Series name or Legend that you want to change.

> Type the new name.

> Press the Enter key to add the new name to the chart.
Changing the Chart Type
There are 14 different types of charts in Excel 2003, and, with each chart type, there can be
several variations. You can see that you can create any number of different charts. The Chart
Type can be changed at any time with a couple of clicks of the mouse.
To Select a Different Chart Type:

> Click on the chart to select it for editing.

» Click on the Chart Type dropdown list box and select a different chart.

The new chart replaces that one selected for change.

5.4 Formatting a Chart

Formatting the Chart Title
The Chart Title can be formatted to change color, pattern, typeface, size and alignment using
the Format Chart Title dialog box.
To format the chart title:
» Select the Chart Title.
> Click the Format Button on the Chart Toolbar (or double click the Chart Title).
> The Format Chart Title dialog box contains three different tabs-Patterns, Font and
Alignment-that can be used to format the Chart Title.
> The Patterns tab lets you define borders and fill colors.
> The Font tab lets you define Font, Font Style, Size and Color.
> The Alignment tab lets you define horizontal and vertical cell placement, as well as text

orientation.
> Click the OK button to accept the Chart Title format changes.

Formatting the Chart Legend

The chart legend displays very useful information about the chart. Like a roadmap, the Legend
identifies what different colors or objects represent in the chart. The Chart Legend, like the
Chart Title and Category Axis Labels, can be formatted to your liking.

To Format the Chart Legend:

» Press the show/hide legend button on the Chart Toolbar to turn on the Legend
display. (This button acts like a toggle by turning the display on or off.)

> Click to select the Chart Legend.

> Click the Format Button on the Chart Toolbar (or double click the chart legend).

> The Format Legend dialog box contains three different tabs-Patterns, Font and
Alignment-that can be used to format the Chart Title.

> The Patterns tab lets you define borders and fill colors.

> The Font tab lets you define Font, Font Style, Size and Color.
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> The Placement tab lets you define the location where the Legend will appear on the
chart.
> Click the OK button to accept the Chart Legend format changes.

The only way to change the actual text that appears in the Chart Legend is to change the
Source Data in the worksheet.

Formatting the Axis Labels

We've previously made reference to a Y-axis and an X-axis in Excel. In Excel, a graph
represents a data in two dimensions. The number of items sold in January is data on two
dimensions: number of items and month. The number of items might be plotted on one axis, Y-
axis, while the month may be plotted on the X-axis. The Y-axis runs up-and-down on the graph.
The X-axis runs left-to-right.

When formatting the Axis labels in your chart, you can adjust the numbers on the Scale of the
chart as well as change font, color, and style.

To Format an Axis:

> Click anywhere in the Axis label that you want to edit:
> Click the Format Button on the Chart Toolbar (or double click the chart axis).

> The Format Axis dialog box contains five different tabs-Patterns, Font and Alignment-
that can be used to format the Chart Title.

The Patterns tab lets you define borders and tick marks.

The Scale tab lets you define numeric intervals on the Value (Y) Axis scale.
The Font tab lets you define Font, Font Style, Size and Color.

The Number tab lets you define the format of numbers displayed in the Axis.

The Alignment tabs let you define text orientation.
Click the OK button to accept the Axis format changes.
You can also use the angle axis buttons on the chart toolbar to change the angle of the value

and category axis.
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Changing the Data Series Color

When a chart is created in Excel 2003 you notice that color is automatically applied to the Data
Series. You can keep this format or change it for each Data Series in the chart. Many different
aspects of each data series can be changed, but you'll probably change the color of bars,
columns, pie slices and areas most often.

To Change the Color of a Data Series:

Select the data series that you wish to edit.
Click the Format Button on the Chart Toolbar (or double click the data series).
Use the Format Data Series dialog box to pick a new color.

>
>
>
» Click the OK button to accept the Data Series color changes.

5.5 Defining Page Setup Options

Setting Page Margins

The Page Margins define where on the page Excel will print the worksheet. By default, the top
and bottom margins are set at 1 inch in Excel 2003. The left and right margins are set at .75
inch. Margin settings can be changed to whatever you want. Different margins can be defined
for each worksheet in the workbook.
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To Change the Margins in the Page Setup Dialog Box:

Select the correct worksheet.

Choose File>>Page Setup from the menu bar.

Select the Margins tab.

Use the spin box controls to define the settings for each page margin-Top, Bottom,
Left, Right, Header and Footer.

> Click the OK button to change the margin settings.
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Changing the Page Orientation and Paper Size

The Page tab of the Page Setup dialog box lets you change page orientation (portrait or
landscape) or paper size (e.g., letter size or legal size). The default paper size in Excel 2003 is
8.5 X 11 inches, with a portrait orientation (prints up and down on the long side of the page). A
landscape orientation, on the other hand, prints up and down on the short side of the page.

To Change Page Orientation:

Select the correct worksheet.

Choose File>>Page Setup from the menu bar.

Click on the Page tab.

Choose an Orientation (Portrait or Landscape) for the worksheet.

Select a Paper Size from the list of available paper size options that appear in the list
box.

Click on the paper size.

Click the OK button to accept the page settings.

The Page tab of the Page Setup dialog box lets you shrink the spreadsheet data so it fits on a

specified number of pages when you print. Click the Fit to: option button and enter the desired
number of pages wide and pages tall.

The Page tab of the Page Setup dialog box lets define the resolution of the print job. Print
Quality is measured in dpi, or dots per inch. High dpi provides a better print quality.

Creating Headers and Footers
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Headers and Footers can be added to any worksheet, although not required. A Header is any
information that appear at the top of each page. A Footer prints at the bottom of the page. If you
want a header or footer inserted onto a page then you will have to define them. Excel 2003
defaults to no header and no footer.

To Create a Header:

» Choose File>>Page Setup from the menu bar.

» Select the Header/Footer tab in the Page Setup dialog box.

> Click the Header drop down list and select and of the predefined headers:
OR

> Click the Custom Header button to create your own header. Follow the instructions in
the Header dialog box to make your entry.

> Click the OK button to return to the Page Setup dialog box.

To Create a Footer:

» Choose File>>Page Setup from the menu bar.

» Select the Header/Footer tab in the Page Setup dialog box.

» Click the Footer drop down list and select one of the predefined footers.
OR

> Click the Custom Footer button to create your own footer. Follow the instructions in the
Footer dialog box to make your entry.
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You can insert Placeholder buttons into both the header and footer to format text, insert page
numbers, date, time, filename, or tab name. Excel replaces those placeholders with the
information each represents when the worksheet is printed. Follow the instructions in the
Header and Footer dialog boxes.

Creating Sheet Settings

The Sheet tab in the Page Setup dialog box provides additional print options you may want to
add to your worksheet.
Print Area

By default, Excel prints from the Al to the last occupied cell in a worksheet. You can specify a
different range of cells to print.
Print Titles
» Prints column and row labels on each page of the printout. Specify these rows or
columns in the Rows to Repeat at Top and Columns to Repeat at Left textboxes.
Print - Gridlines

Determines whether gridlines are printed. However, turning off gridlines does not affect their
appearance in Normal View.
Print - Black and White

If you used colors in your worksheet but don't want to waste the ink in your color printer, use
black and white.
Print - Draft Quality

Choose draft quality to print the worksheet without gridlines or graphics.
Print - Row and Column Headings

Click this option to include row numbers and columns letters in your printed document.
Page Order

Determines the order in which worksheets are printed.
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6. Advanced Microsoft Excel Topics

6.1 Using The AutoFilter

Using AutoFilter

The AutoFilter feature makes filtering, or temporarily hiding, data in a spreadsheet very easy.
This allows you to focus on specific spreadsheet entries.

To Use AutoFilter:

» Select Data from the main menu.
» Select Filter>>AutoFilter.
> Click the drop-down arrow next to the heading you would like to filter.
For example, if you would like to only view data from the West Sales Region, click the drop-

down arrow next to Sales Region.
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» Choose the data you would like to display.
o In this example, you would choose West. All other data will be filtered, or hidden,
and only the West Sales Region data is visible.

> Click the drop-down arrow again and select All to display all of your original data.
6.2 Sorting Lists

Sorting Lists

Sorting lists is a common spreadsheet task that allows you to easily reorder your data. The
most common type of sorting is alphabetical ordering, which you can do in ascending or
descending order.

In this example, we will alphabetize the employee names.

To Sort in Ascending or Descending Order:

> Select Data from the main menu.
» Select Sort. The Sort dialog box will appear.
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» Select the category you would like to Sort by.

» Select Ascending to sort in alphabetical order from A to Z. Or to sort in reverse
alphabetical order from Z to A, select Descending.

> Click OK.
To Sort Multiple Categories:

Select Data from the main menu.

Select Sort. The Sort dialog box will appear.

Select the category you would like to Sort by.

Select Ascending to sort in alphabetical order from A to Z.

In the Then by section, select the second category you would like to sort.
Click OK to sort in alphabetical order and by sales region.
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6.3 Grouping Worksheets
Formatting Worksheets
You can format multiple worksheets at the same time in Excel. To do this you must first group
the worksheets together.
To Group and Format Worksheets:
> Click the first sheet tab you would like to format.
» Press and hold the Shift key on your keyboard.
> Click the last sheet tab you would like to format.
For example, if you have a workbook with three worksheets labeled 2005, 2006, and
2007, respectively, you would click the 2005 tab, press and hold the Shift key, and then
click the 2007 tab. Both sheet tabs you clicked, and any in between, will be highlighted.
» Edit one of the worksheets.
Any changes you make to one sheet will appear in all the highlighted sheets. For example, if
you delete a row in the first sheet, that row will no longer appear in any of the highlighted
sheets.

6.5 Applying and Modifying Cell Formats
You may want to modify the appearance of your spreadsheet to make it more visually
appealing. Excel allows you to make cosmetic changes to cell formatting.
To Apply and Modify Cell Formats:
Use your mouse to select the cells you want to modify.
Select Format>>Cells from the main menu. The Format Cells dialog box will appear.
Decide how you want to format the cells.
Select the tabs that allow you to make the desired changes.
Use the Format Cells drop-down menus and tools to make the desired changes.
Click OK.
In the Format Cells Dialog Box You Can Change:
> Number Formatting
> Alignment Formatting
> Font Formatting
> Border Formatting
> And More!

6.6 Creating New Workbooks From Templates
Creating New Workbooks Using Templates
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Excel allows your to create new workbooks using templates, or a predefined pattern. Several
templates are preloaded in Excel and others are located on Microsoft Office Online.
To Create New Workbooks Using Templates On Your Computer:

To
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Open Excel.

Select New from the menu. The New Workbook dialog box will appear.

File>>New from the main menu. The New Workbook task pane will appear.

Click On my computer... in the Templates section of the New Workbook task pane. The
Templates dialog box will appear.

Select the Spreadsheet Solutions tab.

Select the template you wish to use.

Click OK.

reate New Workbooks Using Templates on Office Online:

Open Excel.
Select File>>New from the main menu. The New Workbook task pane will appear.

Click Templates on Office Online in the Templates section of the New Workbook task
pane. Office Online will open in a new browser window.

Browse the template categories and click the link of the category you wish to view.
Click a template link.
Click Download Now to download the template.

6.7 Using Excel’s Data Analysis Tools
Performing Regression

Excel includes a number of add-in tools to assist with a number of data handling, reporting and
analysis functions. In this section the use of one of the most widely used data analysis functions
(regression) is described. In order to use data analysis functions, the following setting should be
carried out:

>
>

>

Select Tools >> Add-Ins
Check Analysis ToolPak as in the Figure below

Click OK
20|

Aadd-Ins available:

Tl Analvsis ToolPak
Analysis ToolPak - vBA

[~ Conditional Sum wizard area |

I~ Euro Currency Tools

I Internet Assistant YBA |

B e
I Lookup Wizard Srowse

~ =
V¥ solver add-in e —— |

=l

—Aanalysis ToolPak

Provides Functions and interfaces For financial and
scientific data analysis

This unpacks the chosen Excel Add-in tools and makes them available for use.

Regression statistics can be useful evaluating past trends and predicting future consequences.
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In order to compute regression follow the following steps:

VVVVVVYVYVYVYVY

Select Tools>>Data Analysis

Select Regression

Click OK

Click on the contract button Z&{ for the Input Y Range box
Highlight the range you want it to be included

Click the expand button [

Click on the contract button Z&{ for the Input X Range box
Highlight the range you want it to be included

Click the expand button [

Check the Labels box

Click on the contract button Z&{ for the Output Range box
Click on a cell (e.g E1)

As a result of the above settings, the regression window should now look like

Regression

21|

[
Input ¥ Range: |$B$1 $B$7 E‘J
Cancel I
Input X Range: |$C$l $CE7 j‘_;!
Hel
[V Labels [~ Constant is Zero _—pl
[~ Confidence Level: |95 Yo
—Output options
(¢ output Range: |$E$1 =

" New Worksheet Ply: I
" New Workbook

Residuals

[~ Residuals
[~ sStandardized Residuals

I Residual Plots
" Line Fit Plots

ormal Probability
I~ mormal Probability Plots ‘

An output which has a similar look with the one below will be displayed or generated.
SUMMARY OUTPUT

Regression Statistics

Multiple R
R Square
Adjusted R Sguare

0.925099607
0.855609263
0.819761604

Standard Error 12269 31609

Cbservations B
ANOWA
off 55 Ms F Significance F
Regression 1 3568060170 3568060170 23.741036592  0.008205005
Residual 4| BO1163324.3| 1502390831.1
Total 5 4169223494
Coefficients | Standard Error t Stat P-walue Lower 95% LUpper 95%

12763.10588
a063.547647

Intercept
STUDENTS

9861.389778
1040.445575

4.872477483 0.008205005

1.294250219 ) 0.265244258 1 -14616.55821 40142 76997

2180.80164 7958.293654
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